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Foreword

Information Communication Technology (ICT) is one of the rapidly changing
area in domain of learning. The main purpose of introducing ICT in schools is to help
the students to make use of different ICT tools in enhancing their learning. The ICT
education helps the students to face the challenges of 21st century and attain the
millennium developmental goals in education. ICT also helps in reducing  the digital
divide among the rural and urban students.

As per the UNESCO “technology can be a powerful education multiplier, but
we must know how to use it. It is not enough to install technology into classrooms- it
must be integrated into learning. Nothing can be substitute for a good teacher. It is not
technology itself that empowers people- empowerment comes from skills and
knowledge”.

The teachers have become more critical than ever- the challenge is how to
enable teachers not only to overcome the technology barriers but also to empower
them to integrate appropriate technology into the teaching and learning process.

This handbook contains the required content in using the different tools and use
them in other subjects i.e. Mathematics, Science, Social Science and languages.

 The SCERT, Telangana, Hyderabad appreciates the efforts of the content experts
and other team members in developing this  ICT handbook. We also acknowledge the
C-DAC, Hyderabad for sharing their content related to software security in the
preparation of this handbook.

We hope, the teacher may find this handbook useful and transact it in the classroom
to enhance the learning levels of the students and also infuse confidence among them
as they were not left behind  in using technology on par with other students who are
studying in corporate schools.

 Director
S C E R T,

Telangana, Hyderabad.
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Instructions to Teachers

The main purpose of introducing ICT in school syllabus is to help the children  understand

how to make use of ICT tools in enhancing their learning.

 This material is meant for teacher only. Hence, the teacher should read, understand

and add their experience while transacting the same to students.

 Prepare a year plan in advance keeping in view of the number of periods available

under computer education.

 Read all the topics given in the handbook and prepare thoroughly before start teaching.

 Refer to relevant material and consult the experts in case of any doubts.

 Before going to practice, the theory/ content should be explained to students then

only demo and practice sessions should be taken up.

 All abbreviations must be thoroughly practised  by the teacher before teaching.

 Update your knowledge in software and hardware in addition to the latest ICT tools.

Use internet to update the knowledge in the given topics.

 Ensure all children get equal opportunities in practices.

 There will be two periods in a week for ICT (Computer Education) subject,

accordingly, teacher has to plan for transaction.

 Few projects are given at the end of the handbook. All students should do these

projects. In addition to these, you may consult your colleagues and identify some

more projects and assign to your students.

Assessment :

Children’s performance should be assessed at the end of each summative based on

the indicators given below:

 Students are able to operate and use the ICT tools;

 Students are able to learn subject-wise content by using ICT tools.
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There is no written test. The children performance should be assessed  through

observation based on their participation and their ability in using the ICT tools in their

learning.

Assessment Indicators
In addition to grading the qualitative Indicators are to be written in the students’

progress report under Computer Education. The following are the indicators:

A1 Students can use all the tools of the ICT and can use them effectively in their learning.

A2 Students can use all the tools of the ICT and able to use them in their learning.

B1 Students are able to use different tools of ICT and able to use most of them in their
learning.

B2 Students are able to use the different tools of ICT and use some of them in their learning.

C1 Students are able to use the ICT tools and able to use a few of them in their learning.

C2 Students are able to use some of the ICT tools and try to use them in their learning.

D1 Students are able to identify the ICT tools and try to use a few of them in their learning.

D2 Students are able to identify some of the ICT tools but they are unable to use them in
their learning.

Note: The computer education is linked with Work Education and made a single

paper under other curricular subject areas. Hence, out of 50 marks, each 25 marks are to be

allotted to Work Education and Computer Education.

*****
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Information and Communication Technology (ICT)

Introduction

The field of Information and Communication Technology (ICT) is evolving at
such a pace, where concepts, technology and terminology are continuously changing.
ICT helps to  bridge the digital divide amongst students of various socio economic and
other geographical barriers. Information and Communication Technology (ICT) is
universally acknowledged as an important catalyst for social transformation and national
progress.

Information and communication technology which is a by-product of science
and technology explosion has revolutionized the world of learning. It is very essential
to integrate IT with education in order to have the advantage of ICT education.

Around the world, policymakers and educators have high hopes for ICT in the
classroom as a springboard to students “21st century  skills”—that  combines  the
competencies of problem solving, critical thinking and managing their own learning
that is needed for success in the global workplace. 

Information and Communication Technology (ICT) has dominated every walks
of life affecting right from bus &  railway reservations, hotel industry, online money
transfers , bill payments, in class room  teaching and learning process, distance
education, e-learning and  film making  etc..

The learning activities through ICT make a difference. Students are much more likely
to learn to solve real-world problems and collaborate productively with their peers, if
their learning activities are carefully designed to offer opportunities.

The aim of 21st Century education is being redefined. It is not only for
employment generation but also to create a better world through understanding and
development of human qualities.

In this context, the Government of India has announced 2010 – 2020 as the
decade of Innovation. For which, reasoning and critical thinking skills are essential.
And these skills are to be inculcated at the school level for which ICT tools and
techniques should be integrated into class room instructions right from the primary
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education level, so that the children develop the required skills.  In this matter the web
is an open source and the child should know how to grab it.

According to UNESCO, education is important to achieve the Millennium
Development goals; the following are reasons for which the ICT in education is a key
aspect. i.e., ‘More people would grow and develop; More people would learn and
know; More people would be equal and just; More children would survive and live;
More mothers would be healthier; More people would be able to combat illness;
More people would think of the future; More people would work together.”

The purpose of this material is to create an awareness and practice among the
student and teacher communities with a “diverse set of technological tools, resources
used to communicate, create, disseminate, store, and manage information.” These
technologies include computers, internet, broadcasting technologies (radio and
television) and telephony.

The relevant and contemporary content, lucid language, attractive illustrations
and constructive exercises make the learning of computers more meaningful and
enriching.

The journey of the student starts right from the ICT tools available in and around
such as Radio, Tape recorder, TV, Mobile and Computer. The students of primary level
learn to draw by using MS & Tux Paint, learn to type small words, sentences, paragraphs,
making documents by using typing tutor and MS Word. Moving away a little from these
applications, the students can learn MS Excel for mathematical calculations & graphs
and MS Power Point for making subject wise presentations. Further, the students learn
the concepts of Data Base Management System (DBMS), Internet, Networking and
computer languages, maintaining the computers and its peripherals. The students are
also introduced to learn about the Antivirus, Computer security and privacy and open
source software technologies.

This material is useful in acquiring the concepts  in a better way which make the
student journey in learning more fruitful and engrossing. It has been developed in tune
with the guidelines given by NCF-2005 and with various activity based methods. This
will lay down a path to create interest to take up high level computer education courses
in future and career.
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The government had initiated Computer Education and Computer Aided Learning
in selected Primary, Upper Primary and High Schools. A huge number of teachers in
the State already have been trained to use computers in their regular class room
transactions and a lot of computer aided learning material also has been developed and
supplied to schools.

As part of Education Technology Policy, the Education Department of Andhra
Pradesh has been developing  a large quantity of material in the form of  Audio
(Radio Programs under Vindam Nerchukundam), Audio and Video based programs (SIET
and SAP Net) and Computer based programs(CDs) in collaboration with NGOs.

The Objectives of the ICT in School Education:

 To inculcate the ICT skills among the students of government schools.

 To bridge the digital divide between rural and urban students.

 To create computer awareness and literacy among students and teachers.

 To provide ICT  environment in schools to make teaching-learning process
effective and interesting

 To train the teachers on computer syllabi, emerging information and
communication technologies.

 To develop confidence in students to use computers in future.

 Student-centered pedagogies that promote personalized and  powerful learning
for students;

  Extending learning beyond the classroom in ways most relevant to  knowledge-
building and problem-solving in today’s world; and

 ICT integration into pedagogy in ways that support learning goals.  It is important
to note that ICT use is not a goal in itself, but a tool to broaden and deepen
learning opportunities.
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Teaching Learning Process

The ICT material has been developed from class 1 to class 10. The teacher can
act as a facilitator to help the students in their learning process. In every Unit the
teacher explains the concepts and students do the activities/projects with ICT tools and
finally able to integrate with their subjects.

Academic Standards and Assessment

Academic Standards

 The students are shall operate and use the ICT tools;

 Students are shall learn subject wise contents through the ICT tools.

Assessment Process

At the end of the each chapter exercises and projects have been given. On the
basis of the students performance appropriate grade may be awarded in summative
assessment.

*****
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Learning Objectives

In this chapter you will be able to understand about;

  How ICT tools help in Education.

Introduction

In this chapter you will come to know how the ICT tools like, Radio, TV, Computer
etc., are used in filed of Education.

How have radio and TV broadcasting been used in education?

Radio and television have been used widely as educational tools since 1920s and
1950s, respectively. There are three general approaches to the use of radio and TV
broadcasting in education: 

 direct class teaching, where broadcast programming substitutes for teachers on a
temporary basis;

 school broadcasting, where broadcast programming provides complementary teaching
and learning resources not otherwise available; and

 general educational programming over community, national and international stations
which provide general and informal educational opportunities.

The notable and best documented example of the direct class teaching approach is
Interactive Radio Instruction (IRI).This consists of “ready-made 20-30 minute direct teaching
and learning exercises to the classroom on a daily basis. The radio lessons, developed around
specific learning objectives at particular levels of maths, science, health and languages in
national curricula, are intended to improve the quality of classroom teaching and to act as a
regular, structured aid to poorly trained classroom teachers in under-resourced schools.”IRI
projects have been implemented in Latin America and Africa. In Asia, IRI was first implemented
in Thailand in 1980; Indonesia, Pakistan, Bangladesh and Nepal rolled out their own IRI projects
in the 1990s. What differentiates IRI from most other distance education programs is that its
primary objective is to raise the quality of learning—and not merely to expand educational
access—and it has had much success in both formal and non-formal settings.  Extensive

ICT tools in Education – Benefits
and Limitations

Chapter - 1
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research around the world has shown that many IRI projects have had a positive impact on
learning outcomes and on educational equity. And with its economies of scale, it has proven to
be a cost-effective strategy relative to other interventions. 

Mexico’s Telesecundaria is another notable example of direct class teaching, this
time using broadcast television. The programme was launched in Mexico in 1968 as a cost-
effective strategy for expanding lower secondary schooling in small and remote communities.
Perraton describes the programme thus:

Centrally produced television programs are beamed via satellite throughout the
country on a scheduled basis (8 am to 2 pm and 2 pm to 8 pm) to Telesecundaria schools,
covering the same secondary curriculum as that offered in ordinary schools. Each hour
focuses on a different subject area and typically follows the same routine—15 minutes of
television, then book-led and teacher-led activities. Students are exposed to a variety of
teachers on television but have one home teacher at the school for all disciplines in each
grade. 

The design of the programme has undergone many changes through the years, shifting
from a “talking heads” approach to more interactive and dynamic programming that “link[s]
the community to the programme around the teaching method. The strategy meant combining
community issues into the programs, offering children an integrated education, involving
the community at large in the organization and management of the school and stimulating
students to carry out community activities.” 

Assessments of Tele secondary have been encouraging: drop out rates are slightly
better than those of general secondary schools and significantly better than in technical
schools.

In Asia, the 44 radio and TV universities in China (including the China Central Radio
and Television University), University as Terbuka in Indonesia, and Indira Ghandi National
Open University have made extensive use of radio and television, both for direct class
teaching and for school broadcasting, to reach more of their respective large populations.
For these institutions, broadcasts are often accompanied by printed materials and audio
cassettes.

Japan’s University of the Air was broadcasting 160 television and 160 radio courses
in 2000. Each course consists of 15-45 minute lectures broadcast nationwide once a week
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for 15 weeks. Courses are aired over University-owned stations from 6 am to 12 noon.
Students are also given supplemental print materials, face-to-face instruction, and online
tutorials.. 

Often deployed with print materials, cassettes and CD-ROMS, school broadcasting,
like direct class teaching, is geared to national curricula and developed for a range of subject
areas. But unlike direct class instruction, school broadcasting is not intended to substitute
for the teacher but merely as an enrichment of traditional classroom instruction. School
broadcasting is more flexible than IRI since teachers decide how they will integrate the
broadcast materials into their classes. Large broadcasting corporations that provide school
broadcasts include the British Broadcasting Corporation, Education Radio TV in the United
Kingdom and the NHK Japanese Broadcasting Station. In developing countries, school
broadcasts are often a result of a partnership between the Ministry of Education and the
Ministry of Information.

What is teleconferencing and what have been its educational uses?

Teleconferencing refers to “interactive electronic communication among people
located at two or more different places.”  There are four types of teleconferencing based
on the nature and extent of interactivity and the sophistication of the technology:
1) audio conferencing; 2) audio-graphic conferencing, 3) video conferencing; and 4) Web-
based conferencing.

Audio conferencing involves the live (real-time) exchange of voice messages over
a telephone network. When low-bandwidth text and still images such as graphs, diagrams or
pictures can also be exchanged along with voice messages, then this type of conferencing
is called audio graphic . Non-moving visuals are added using a computer keyboard or by
drawing/writing on a graphics tablet or whiteboard.

Videoconferencing allows the exchange not just of voice and graphics but also of
moving images. Video conferencing technology does not use telephone lines but either a
satellite link or television network (broadcast/cable). Web-based conferencing, as the name
implies, involves the transmission of text, and graphic, audio and visual media via the Internet;
it requires the use of a computer with a browser and communication can be both synchronous
and asynchronous.
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Teleconferencing is used in both formal and non-formal learning contexts to facilitate
teacher-learner and learner-learner discussions, as well as to access experts and other
resource persons remotely. In open and distance learning, teleconferencing is a useful tool
for providing direct instruction and learner support, minimizing learner isolation. For
instance, an audio graphic teleconferencing network between Tianjin Medical University in
China and four outlying Tianjin municipalities was piloted in 1999 as part of a multi-year
collaboration between Tianjin Medical University and the University of Ottawa School of
Nursing funded by the Canadian International Development Agency. The audio-graphic
teleconferencing network aims to provide continuing education and academic upgrading to
nurses in parts of Tianjin municipality where access to nursing education has been extremely
limited.  Other higher education institutions using teleconferencing in their online learning
programs include the Open University of the United Kingdom, Unitar (University Tun Abdul
Ruzak) in Malaysia, Open University of Hong Kong, and Indira Gandhi National Open
University.

How have computers and the Internet been used for teaching and learning? 

There are three general approaches to the instructional use of computers and the
Internet, namely:

 Learning about computers and the Internet, in which technological literacy is the
end goal;

 Learning with computers and the Internet, in which the technology facilitates learning
across the curriculum; and

 Learning through computers and the Internet, integrating technological skills
development with curriculum applications.

Summary

 In this chapter you have learnt about various ICT Tools.

 Explain students with available articles on usage of ICT in field of Education.

  Curriculum   Integrating   White board          Video conference

*****

Teacher Activity

Key Words
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Learning objectives

In this chapter you will be able to understand about ;

Types of Laptops

Television

About Laptops

Laptop computers, also known as notebooks, are portable computers that you can
take with you and use in different environments. They include a screen, keyboard, and a
trackpad or trackball, which serves as the mouse. Because laptops are meant to be used on
the go, they have a battery which allows them to operate without being plugged into a power
outlet. Laptops also include a power adapter that allows them to use power from an outlet
and recharges the battery.

While portable computers used to be significantly slower and less capable than
desktop computers, advances in manufacturing technology have enabled laptops to perform
nearly as well as their desktop counterparts. In fact, high-end laptops often perform better
than low or even mid-range desktop systems. Most laptops also include several I/O ports,
such as USB ports, that allow standard keyboards and mice to be used with the laptop. Modern
laptops often include a wireless networking adapter as well, allowing users to access the
Internet without requiring any wires.

While laptops can be powerful and convenient, the convenience often comes at a
price. Most laptops cost several hundred dollars more than a similarly equipped desktop
model with a monitor, keyboard, and mouse. Furthermore, working long hours on a laptop
with a small screen and keyboard may be more fatiguing than working on a desktop system.
Therefore, if portability is not a requirement for your computer, you may find better value
in a desktop model

More History of Laptops

 Released in 1981, was the Epson HX-20, a battery powered portable computer, with
a 20-character by 4 line LCD display and a built-in printer.

Types  of  ICT  Tools  – Laptop,
Television

Chapter - 2



SCERT, T.S, Hyderabad10

 In January of 1982, Microsoft’s Kazuhiko Nishi and Bill Gates begin discussions
on designing a portable computer, based on using a new liquid crystal display or LCD
screen. Kazuhiko Nishi later showed the prototype to Radio Shack who agree to
manufacture the computer.

 In 1983, Radio Shack released the TRS-80 Model
100, a 4 lb. battery operated portable computer
with a flat and more of a laptop design.

 In February 1984, IBM announced the IBM
5155 Portable Personal Computer.

 Three years later in 1986, Radio Shack released
the improved and smaller TRS Model 200.

 In 1988, Compaq Computer introduces its first laptop PC with VGA graphics - the
Compaq.

 In 1989, NEC Ultrafine was released, considered by some to be the first “notebook
style” computer. It was a laptop size computer which weighed under 5 lbs. (second
photo)

 In September 1989, Apple Computer released the first Macintosh Portable that later
evolved into the Powerbook. (second photo)

 In 1989, Zenith Data Systems released the Zenith
Miniport,  a 6-pound laptop computer.
(more Zenith laptops)

 In October 1989, Compaq Computer released its
first notebook PC, the Compaq LTE.

 In March 1991, Microsoft released the Microsoft
BallPoint Mouse that used both mouse and
trackball technology in a pointing device designed for laptop computers.

 In October 1991, Apple Computers released the Macintosh Power Book 100, 140,
and170 - all notebook style laptops. (more on PowerBooks)

 In October 1992, IBM released its ThinkPad 700 laptop computer.
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 In 1992, Intel and Microsoft release APM or the Advanced Power Management
specification for laptop computers.

 In 1993, the first PDAs or Personal Digital Assistants are released. PDAs are pen-
based hand-held computers.

About Television

Television was not invented by a single inventor, instead many people working
together and alone over the years, contributed to the evolution of television.

At the dawn of television history there were two distinct paths of technology
experimented with by researchers.

Early inventors attempted to either build a mechanical television system based on
the technology of Paul Nipkow’s rotating disks; or they attempted to build an electronic
television system using a cathode ray tube developed independently in 1907 by English
inventor A.A. Campbell-Swinton and Russian scientist Boris Rosing.

Electronic television systems worked better and eventual replaced mechanical
systems.

German, Paul Nipkow developed a rotating-disc technology to transmit pictures over
wire in 1884 called the Nipkow disk. Paul Nipkow was the first person to discover
television’s scanning principle, in which the light intensities of small portions of an image
are successively analyzed and transmitted.

In the 1920’s, John Logie Baird patented the idea of using arrays of transparent rods
to transmit images for television. Baird’s 30 line images were the first demonstrations of
television by reflected light rather than back-lit silhouettes. John Logie Baird based his
technology on Paul Nipkow’s scanning disc idea and later developments in electronics.

Charles Jenkins invented a mechanical television system called radiovision and
claimed to have transmitted the earliest moving silhouette images on June 14, 1923.

Electronic television is based on the development of the cathode ray tube, which is
the picture tube found in modern TV sets. German scientist, Karl Braun invented the cathode
ray tube.
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The Indian Beginning - Television
Television first came to India [named as ‘Doordarshan’ (DD)] on Sept 15, 1959 as

the National Television Network of India. The first telecast started on Sept 15, 1959 in New
Delhi. After a gap of about 13 years, second television station was established in Bombay in
1972 and by 1975 there were five more television stations at Shrinagar (Kashmir), Amritsar
(Punjab), Calcutta, Madras and Lucknow. For many years the transmission was mainly in
black & white. Television industry got the necessary boost in the eighties when Doordarshan
introduced colour TV during the 1982 Asian Games (http://www.indiantelevision.com/
indianbrodcast/history/historyoftele.htm). The second phase of growth was witnessed in
the early nineties and during the Gulf War, that foreign channel like CNN, Star TV and
domestic channels such as Zee TV and Sun TV started broadcast of satellite signal. This
changed the scenario and the people got the opportunity to watch regional, national and
international programmes. Starting with 41 sets in 1962 and one channel (Audience Research
unit, 1991) at present TV in India covers more than 70 million homes giving a viewing
population more than 400 million individuals through more than 100 channels (http://
www.indiantelevision.com). Easy accessibility of relevant technology, variety of programmes
and increased hour of transmission are main reasons for rapid expansion of TV system in
India.

Major educational projects in India 
In India, since the inception of TV network, television has been perceived as an

efficient force of education and development. With its large audience it has attracted
educators as being an efficient tool for imparting education to primary, secondary and
university level students. Some of the major educational television projects are discussed
as hereunder:

Summary
We have learnt about; Portable device – Laptop and about

About Television.

 Demonstrate the usage of Television and Laptop in the class room.

 Cathode ray   Electronics   Portable

*****

Teacher Activity

Key Words
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Learning objectives

In this chapter you will be able to understand about ;

   Scanner

   Web Camera

   Microphone.

Scanner

A computer scanner is used to convert a hard copy, that
is document you can hold in your hand, into data that your
computer can read. Take the document you want to scan and
place it data side down on the glass plate of the scanner then
close the cover. Choose scan document from the scanner menu.
If the scanner is powered on and connected via a data cable to
your computer the scanner will send.

Types :

 There are three common types of scanners; handheld, sheet-fed and flatbed scanners.
Handheld scanners are typically used to scan bar codes. Sheet-fed scanners come in
stand-alone versions or as part of an all-in-one printer, copier and fax machine. Flatbed
scanners have a glass panel like a copier, but are smaller, lighter and have no apparatus
for printing copies.

Function :

 Many scanners convert text and images on physical media into image data. In most
cases, you can select the file format in which the image file is saved. Image types
include Windows bitmap, .jpeg, .gif, .tiff, .png and .pcx. For a scanner to convert
printed text into a text file, optical character recognition (OCR) software must be
installed on the computer.

Parts of ICT  – Scanner, Web
camera, Microphone

Chapter - 3
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Web Camera

A webcam – short for ‘web camera’  is
a digital camera that is connected to a
computer. It can send live pictures from
wherever it’s sited to another location by
means of the internet. Many desktop computer
screens and laptops come with a built-in
camera and microphone, otherwise you can
add a separate webcam at any time.   There are various types. Some are plugged into computers
through USB ports, but others are wireless (wifi). Other features might include:   an integral
microphone the ability to pan and tilt in-built sensors that can detect movement and start
recording a light that, when on, will let you know that the camera is in use. There’s a wide
range of things that you can do with a webcam. The most common is to video chat over the
internet using Skype – see our Skype guides for all the information you need to get going. 
  And always remember, and remind your children, that any images you make available to
others via your webcam could remain on the internet forever.

Microphone

A device that converts sound waves into analogous electrical waves. Usually called
a “mike,” it contains a flexible diaphragm composed of film or foil that vibrates as it makes
contact with the sound. The diaphragm movement modulates an electrical current by various
methods. In a carbon mike, used in telephones for more than a hundred years, the diaphragm
alters the pressure in carbon grains, changing its resistance.

Condenser Microphones

In a condenser mike, also called an “electrostatic mike” or “capacitor mike,” the
diaphragm changes the capacitance between itself and a metal plate, both acting as electrodes.
The widely used electret mike has a charged dielectric between the electrodes that generates
voltage.

Crystal and Dynamic Microphones

Crystal microphones use a piezoelectric diaphragm that
produces voltage when subjected to the sound waves (mechanical
pressure).
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Dynamic mikes, which are like speakers in reverse, use a diaphragm attached to a
movable coil that generates voltage as air moves the coil between the poles of a magnet.

Summary

 In this chapter we have learnt about;

 Scanners

 Web Camera

 Microphone.

 Demonstrate the usage of the above devices in the class room.

 Identify the tools, write short notes on tools, collect various pictures from news
papers and magazines and make a Album.

 Scanning

 Flat Bed scanner

 Diagraph

*****

Teacher Activity

Student Activity

Key Words
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Learning objectives

In this chapter you will be able to understand about ;

  Printers and their types.

Printers are Output devices used to prepare permanent Output devices on paper.
Printers can be divided into two main categories.

Impact Printers : In this hammers or pins strike against a ribbon and paper to print
the text. This mechanism is known as electro-mechanical mechanism. They are of two
types.

(i) Character Printer

(ii) Line Printer

Character Printer : It prints only one character at a time. It has relatively slower
speed. Eg. of them are Dot matrix printers.

Dot Matrix Printer : It prints characters as combination of dots. Dot matrix printers
are the most popular among serial printers. These have a matrix of pins on the print head of
the printer which form the character. The computer memory sends one character at a time
to be printed by the printer. There is a carbon between the pins & the paper. The words get
printed on the paper when the pin strikes the carbon. There are generally 24 pins.

Impact

Character
Printer

Lines Printer

Dot Matrix

Printer

Non-Impact

Character
Printer

Page Printer

Ink-Jet Laser

Printers – Types of PrintersChapter - 4
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Laser Printer is a type of printer that utilises a laser beam to produce an image on
a drum. The light of the laser alters the electrical charge on the drum wherever it hits. The
drum is then rolled through a reservoir of toner, which is picked up by the charged portions
of the drum. Finally, the toner is transferred to the paper through a combination of heat and
pressure.

This is also the way copy machines work. Because an entire page is transmitted to a
drum before the toner is applied, laser printers are sometimes called page printers. There
are two other types of page printers that fall under the category of laser printers even though
they do not use lasers at all. One uses an array of LEDs to expose the drum and the other
uses LCDs. Once the drum is charged, however, they both operate like a real laser printer.
One of the chief characteristics of laser printers is their resolution – how many dots per
inch (dpi) they lay down.

The available resolutions range from 300 dpi at the low end to 1,200 dpi at the high
end. In addition to text, laser printers are very adept at printing graphics, so you need
significant amounts of memory in the printer to print high-resolution graphics. To print a
full-page graphic at 300 dpi, for example, you need at least 1 MB (megabyte) of printer RAM.
For a 600 dpi graphic, you need at least 4 MB RAM.

Because laser printers are non-impact printers, they are much quieter than dotmatrix
or daisy-wheel printers. They are also relatively fast, although not as fast as some dot-
matrix or daisy-wheel printers. The speed of laser printers ranges from about 4 to 20 pages
of text per minute (ppm). A typical rate of 6ppm is equivalent to about 40 characters per
second (cps).

Non-Impact Printers : There printers use non-impact technology such as ink-jet
or laser technology. There printers provide better quality of O/P at higher speed. These
printers are of two types :

Ink-Jet Printer : It prints characters by spraying patterns of ink on the paper from
a nozzle or jet. It prints from nozzles having very fine holes, from which a specially made
ink is pumped out to create various letters and shapes. The ink comes out of the nozzle in a
form of vapors. After passing through a reflecting plate, it forms the desired letter/shape at
the desired place.
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Summary

 In this chapter we have learnt about;

 Printer and types of printers.

 Try to demonstrate the usage of printer in the computer lab, try displaying different
types of printer available within school campus.

 Try printing documents using the printer, observe and record the printers available
in your market.

 Impact

 Non Impact

*****
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Learning objectives

In this chapter you will be able to understand about ;

 Modem

 Network Interface Card

About Modem

A modem (modulator-demodulator) is a device that modulates an analog carrier
signal to encode digital information and demodulates the signal to decode the transmitted
information. The goal is to produce a signal that can be transmitted easily and decoded to
reproduce the original digital data. Modems can be used with any means of transmitting
analog signals, from light emitting diodes to radio. The most familiar type is a voice
band modem that turns the digital data of a computer into modulated electrical signals in
the voice frequency range of a telephone channel. These signals can be transmitted over
telephone lines and demodulated by another modem at the receiver side to recover the
digital data.

Modems are generally classified by the amount of data they can send in a given unit
of time, usually expressed in bits per second (bit/s or bps), or bytes per second (B/s).
Modems can also be classified by their symbol rate, measured in baud. The baud unit denotes
symbols per second, or the number of times per second the modem sends a new signal. For
example, the ITU V.21 standard used audio frequency shift keying with two possible
frequencies, corresponding to two distinct symbols (or one bit per symbol), to carry 300
bits per second using 300 baud. By contrast, the original ITU V.22 standard, which could
transmit and receive four distinct symbols (two bits per symbol), transmitted 1,200 bits by
sending 600 symbols per second (600 baud) using phase shift keying.

History

News wire services in the 1920s used multiplex devices that satisfied the definition
of a modem. However the modem function was incidental to the multiplexing function, so
they are not commonly included in the history of modems. Modems grew out of the need
to connect teleprinters over ordinary phone lines instead of the more expensive leased

Modem and NICChapter - 5
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lines which had previously been used for current loop–based
teleprinters and automated telegraphs. In 1942, IBM adapted
this technology to their unit record equipment and were able
to transmit punched cards at 25 bits/second.[citation needed]

Mass-produced modems in the United States began as
part of the SAGE air-defense system in 1958 (the year the
word modem was first used[1]), connecting terminals at various
airbases, radar sites, and command-and-control centers to the SAGE director centers
scattered around the U.S. and Canada. SAGE modems were described by AT&T’s Bell Labs as
conforming to their newly published Bell 101 dataset standard. While they ran on dedicated
telephone lines, the devices at each end were no different from commercial acoustically
coupled Bell 101, 110 baud modems.

In summer 1960[citation needed], the name Data-Phone was introduced to replace
the earlier term digital subset. The 202 Data-Phone was a half-duplex asynchronous service
that was marketed extensively in late 1960[citation needed]. In 1962[citation needed],
the 201A and 201B Data-Phones were introduced. They were synchronous modems using
two-bit-per-baud phase-shift keying (PSK). The 201A operated half-duplex at 2,000 bit/s
over normal phone lines, while the 201B provided full duplex2,400 bit/s service on four-
wire leased lines, the send and receive channels each running on their own set of two wires.

The famous Bell 103A dataset standard was also introduced by AT&T in 1962. It
provided full-duplex service at 300 bit/s over normal phone lines. Frequency-shift keying was
used, with the call originator transmitting at 1,070 or 1,270 Hz and the answering modem
transmitting at 2,025 or 2,225 Hz. The readily available 103A2 gave an important boost to
the use of remote low-speed terminals such as the Teletype Model 33 ASR and KSR, and
the IBM 2741. AT&T reduced modem costs by introducing the originate-only 113D and
the answer-only 113B/C modems.

Network Interface Card

A network interface controller (NIC, also
known as a network interface card, network
adapter, LAN adapter, and by similar terms) is
a computer hardware component that connects
a computer to a computer network.



ICT Teacher Hand Book 21

Early network interface controllers were commonly implemented on expansion
cards that plugged into a computer bus; the low cost and ubiquity of the Ethernet standard
means that most newer computers have a network interface built into the motherboard.

Purpose

The network controller implements the electronic circuitry required to communicate
using a specific physical layer and data link layer standard such as Ethernet, Wi-Fi or Token
Ring. This provides a base for a full network protocol stack, allowing communication among
small groups of computers on the same LAN and large-scale network communications
through routable protocols, such as IP.

Summary

 In this chapter we have learnt about

 Modem

 Network Interface Card NIC.

 Show modem and Network Cars and Explain.

 Identify the difference between modem & Network Card.

 Wi-fi

 Ethernet

 Network Card

*****
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Learning Objectives

In this chapter you will be able to understand about ;

 Different components of the system unit

 Microprocessor

 Booting process

 How the characters are represented in computers

 Different types of printers

The System Unit and its Components

The system unit is a box-like
structure that has all the components
required to run the computer, with each
component performing a specific function.
These components work together to
accomplish the main function of the
computer, that is, accept and process input,
and deliver output. The major components
of the system unit are power supply, exhaust
fan, speaker, motherboard, and hard disk drive.

Each of these components and their functions are discussed below.

Internal Power Supply

The system unit draws power from AC mains. The internal components of a computer
run on DC power. The conversion of AC power to DC power is taken care of by a component
called Internal Power Supply. It is usually referred to as Switched Mode Power Supply
(SMPS). Thus, the SMPS provides the required voltage to the other internal components
like CD disk drive, hard disk drive, motherboard and external devices like the keyboard.

The System UnitChapter - 6
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Exhaust Fan

The SMPS has a small fan, called the exhaust fan, attached to it. The fan works as
long as the computer is switched on and keeps the SMPS unit cool.

Speaker

The system unit has an audio speaker attached to it. This speaker is connected to the
motherboard and produces a sound whenever instructed by software programs. For example,
when you switch on the computer, the system plays a beep sound.

The system unit contains a large board that has a number of tiny electronic circuits
and other components. This board is called the motherboard. It is a very important part of
the system unit and houses several vital components of the computer.

The components of the motherboard are:

 Microprocessor  Clock chip  Memory – RAM and ROM

 Bus  Ports  Expansion slots

Note : The peripheral devices like printer, keyboard and monitor are also attached to the
system unit.

Microprocessor :

The microprocessor chip or the Central Processing Unit is the most important
component of the system unit. The microprocessor can take in data, perform arithmetic or
logical operations on the data and send out the result.

The microprocessor consists of the Arithmetic and Logic Unit (ALU), Control Unit
and special storage areas called registers.

Arithmetic and Logic Unit :

Arithmetic and Logic Unit (ALU) is that part of the CPU where actual processing of
data takes place. All calculations involving addition, subtraction, multiplication or division
are performed on the data by the circuits present in this unit. It also performs operations on
data to check if they are equal, or if one of them is greater than the other, etc. Intermediate
results generated in the arithmetic-logic unit are temporarily stored in registers.



SCERT, T.S, Hyderabad24

Control Unit :

The control unit, as the name suggests, controls the working of the computer and
ensures that the computer is functioning as per the commands given to it by the user. It acts
like the central nervous system for all the components, though it does not process any data.

Registers :

Registers are storage areas, which are physically a part of the microprocessor chip.
The microprocessor uses them to store temporary results and control information. They
are number of registers present varies among different computers.

Note : The capacity of a microprocessor is measured in terms of the number of bits
it can send and receive and the number of bits it can process internally. Most of the
microprocessor chips available today are 32-bit systems, that is, they can send and receive
32 bits of data and internally process 32 bits of data at a time.

Clock chip :

A clock chip is used as a timekeeper to enable the components of the computer to
work in Synchronization. It provides the timing signal in the form of electronic pulses that
are used by the components to set a working pace.

The speed of a clock is measured in terms of frequency of pulses generated. The
unit used for measuring this frequency is MHz (Mega Hertz). If the clock speed is 1 MHz,
it means that the clock produces 1 million pulses per second. The clock speed of PCs
ranges from a low of 16 MHz to a high of 1500 MHz. The clock speed is one of the ways of
measuring the speed of a computer.

Memory :

The internal memory, both RAM and ROM, of a computer is present on the
motherboard in the form of chips. RAM is the memory that the computer uses for storing
programs and data while it is working with them. Data within the RAM can be read or modified,
that is, you can either read from the RAM or write onto it. Hence it is called read/write
memory. RAM is also known as short-term memory or volatile memory because once the
power supply is cut, all the data in the RAM is erased. The storage capacity of RAM available
nowadays is ranging from 512MB to 4GB or more. The more the storage capacity of RAM,
the more is the processing power of the computer.
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There are two basic types of RAM :

 Dynamic RAM (DRAM) - It is the most commonly used type of memory in personal
computers and workstations. DRAM supports access times of about 60 nanoseconds.

 Static RAM (SRAM) – It need not be refreshed frequently. It is faster and more
reliable than DRAM. SRAM supports access times as low as 10 nanoseconds.
However, it is more expensive than DRAM and thus, has so far found use only as a
memory cache.

Cache Memory :

It is a high-speed memory area that the CPU can access quickly. It can be located on
the microprocessor or somewhere on the motherboard. It is used in computers with very
fast CPUs. The most frequently used instructions are stored in this memory.

Virtual Memory :

Virtual memory is the use of space on a hard disk drive (HDD) to simulate additional
main memory.

Virtual Memory is an imaginary memory area supported by some operating systems
in combination with the hardware. Virtual memory is an alternate set of memory addresses.

Programs use these virtual addresses rather than real addresses to store instructions
and data.

Bus :

The microprocessor works on data present in the memory chips. The communication
between the microprocessor and the memory chips as well as other chips found on the
motherboard takes place through a set of wires. These set of wires are called as bus.

Port :

Ports are inlets and outlets through which the input and output devices are connected
to the system unit.

Expansion slots :

The number of ports available on the system unit is limited. To accommodate more
number of devices, the system unit provides a set of sockets available on the motherboard
called expansion slots. These slots can be used to add extra memory or any other additional
devices.
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Display Cards

Display card is the important factor to be considered because all the graphical
performance of the system depends on the display card you select. Here are some facts
about the display cards.

CGA

Abbreviation of color graphics adapter, an old graphics system for PCs. Introduced
in 1981 by IBM, CGA was the first color graphics system for IBM PCs. Designed primarily
for computer games, CGA does not produce sharp enough characters for extended editing
sessions. CGA’s highest-resolution mode is 2 colors at a resolution of 640 by 200.

EGA

Abbreviation of enhanced graphics adapter, a graphics display system for PCs
introduced by IBM in 1984. EGA supports 16 colors from a palette of 64 and provides a
resolution of 640 by 350. This is better than CGA but not as good as VGA. EGA is now
obsolete.

VGA

Abbreviation of video graphics array, a graphics display system for PCs developed
by IBM. VGA has become one of the de facto standards for PCs. In text mode, VGA systems
provide a resolution of 720 by 400 pixels. In graphics mode, the resolution is either 640 by
480 (with 16 colors) or 320 by 200 (with 256 colors). The total palette of colors is 262,144.

SVGA

Short for Super VGA, a set of graphics standards designed to offer greater resolution
than VGA. SVGA supports 800 x 600 resolution, or 480,000 pixels.

The SVGA standard supports a palette of 16 million colors, but the number of colors
that can be displayed simultaneously is limited by the amount of video memory installed in
a system.

One SVGA system might display only 256 simultaneous colors while another displays
the entire palette of 16 million colors. The SVGA standards are developed by a consortium
of monitor and graphics manufacturers called VESA.
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Disk Drives

Disk drives are special devices present in the system unit that are used to read from
and write to external storage media like hard disks, CD disks, etc. The disk drive performs
the function of reading data from the disk as well as writing data to the disk. Hence, disk
drive is an Input- Output (I/O) device.

The disk drive used to read from and write to a hard disk is called a hard disk drive.

Booting Process

When the computer is switched on, a series of steps are executed before you can
start using the computer. As a first step, the processor starts executing the ROM-BIOS
instructions, which are in the ROM portion of the memory. ROM-BIOS instructions are
stored permanently in ROM and get activated each time the computer is started.

The first activity performed by ROM-BIOS is to test if the computer is in good
working order.This testing activity of ROM-BIOS is called Power-on self test (POST).
POST checks all theareas of RAM memory for defects and also looks at the connections to
the keyboard, disk drive etc. to see if they are functional.

The next activity of ROM-BIOS is to bring in the operating system from the disk
into the memory. This process involves a number of activities.

First, ROM-BIOS attempts to locate the operating system boot files on the CD disk
drive or the hard disk drive. If for some reason, the system files are not found on either of
these drives, then the ROMBIOS displays an appropriate error message and stops further
processing. If ROM-BIOS is able to locate the system files on a disk, it copies information
from the first sector of the disk. This information is called the Master Boot Record (MBR).
The MBR identifies how and where an operating system is located so that it can be loaded
into the RAM. The MBR contains a program, which is loaded into RAM.

The BIOS hands over control to the program on the MBR, which loads the initial
system file into RAM from the CD disk or hard disk. The initial file then loads the rest of
the operating system into RAM. At this point, the MBR is no longer required. The initial
file loads a system file also, that knows how to work with the BIOS.

One of the first operating system files that get loaded into RAM is a system
configuration file. This file contains information as to which operating system files need
to be loaded.
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Another special file that is loaded contains information as to which applications or
commands need to be executed as part of the boot process.

After all the OS files are loaded, the operating system is given control of the computer.
It performs the requested initial commands and then waits for the first user input. The
process of loading the operating system is represented diagrammatically above.

Representation of Characters

You are aware of the various parts of a computer and how they work. It is also necessary
to understand as to how characters are represented in the computer.

Switch on the Computer

ROM-BIOS does a power
on Self Test

ROM-BIOS attemps to
locate the system files

ROM-BIOS loads the
MBR into RAM

ROM-BIOS hands over
control to the program on

the MBR

The program loads the
initial system file into

The initial file loads the rest
of the OS into RAM

Successful

Unsuccessful

The OS is given control of
the computer

Displays an error message
and stops further
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Computers use a combination of binary digits 1 and 0 to represent a character. Each
of these binary digits is called a bit. A collection of 8 bits is called a byte, which is used to
represent a character in the computer.

Various combinations of bits can be used to represent unique characters. There are
different methods of representing characters in a computer. The most widely used method
is the ASCII. It is the acronym for American Standard Code for Information Interchange.

Summary

 The major components of the system unit are power supply, exhaust fan, speaker,
motherboard, CD disk drive and hard disk drive.

 The bootstrap process is the loading of the operating system DOS into the RAM.

 Computers use binary digits 1 and 0 to represent a number or character. Each of
these binary digits is called a bit.

 A collection of 8 bits is called as byte, which is used to represent a character in the
computer.

 Show the Internal parts of CPU.

 Identification of parts in CPU.

 Colour Graphics Adapter (CGA)

 Enhanced Graphic Adapter (EGA)

 Video Graphic Adapter (VGA)

 Super Video Graphic Adapter (SVGA)

 Expansion Slot    Port

 Cashe Memory   Virtual Memory

*****
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Learning objectives

In this chapter you will be able to understand about ;

 Use the options in the Control Panel

 Browse the network using Network Neighborhood

 Explain the use of System Tools

 Maintain a computer properly

 Prevent Virus

Exploring the Control Panel

Control Panel contains a set of
specialised tools. These tools are used to
change the settings and behavior of Windows
operating system. They are also used to find
some general details about the computer, such
as the computer name, memory capacity, hard
disk space etc.

To access the Control Panel,

1. Click the Start button.

2. Click the Control Panel option on the menu.

The tools in the Control Panel can be viewed in two ways:

  Category View

  Classic View

In the Category view, the icons will be organized by category. If you want to view a
particular item, click the Switch to Classic View option (refer Figure 1). In the Classic
view, each item will be displayed separately and not as a group. By default, the items in the
Control Panel will be displayed in the Category view.

Windows Utility Security and CareChapter - 7
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The System Icon

The System icon in the Control Panel
(refer Figure 2) is used to view general
information about the computer. It can be used
to,

 View and change the settings of the
computer.

 Find information about hardware and
device properties of the computer.

 View network information such as the computer name or the workgroup name.

To open the System Properties window;

1. Open the Control Panel,

2. Switch to Classic View,

3. Double-click the System icon.

Figure 3 shows the System Properties dialog box.

The General Tab

The General tab section in the System Properties
dialog box (refer Figure 4) displays information about
the computer, such as the name of the operating system

installed, the person in whose name the system is registered, the microprocessor used, and
the memory capacity of the computer

The Computer Name Tab

The Computer Name tab in the system properties
dialog box  displays the name of the computer. It displays
the computer description, full computer name and
workgroup to which the computer belongs

Windows XP allows you to change the name of the
computer and also the description about the computer.
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To change the name of the computer,

1. Click the Change button.

The Computer Name Changes dialog box is displayed.

2. Enter the new name in the Computer Name
text box (refer Figure 5).

3. Click the OK button.

4. Windows prompts you to restart the
computer.

5. Click the OK button of the dialog box.

6. Click the OK button of the System Properties dialog box.

A message window will prompt whether you want to restart the computer immediately
or later.

Click the Yes button to view the changes.

Disk Drive Capacity

Every system has a certain memory
capacity. The hard disk is usually partitioned
into a number of drives, each with a certain
memory space.

To find the memory space available
in a particular hard disk.

1. Click the Start button and click the

My Computer option. The My Computer
window is displayed .

2. Click the required drive from the right pane.

The details about the computer such as the file system used, free memory space and
the total size of the disk drive will be displayed under the Details section on the left pane
of the My Computer window.

Figure 6
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Some of the components in Control Panel and their purpose are listed

My Network Places

My Network Places  helps in viewing the information stored in different computers
on the network. Information can be transferred from one computer to another through cables,
satellite links or electronic waves. A group of computers and other devices like printers
when connected by cables and other hardware is referred to as a network of computers. In
other words, a computer network contains a group of computers that can communicate
with each other.

System Tools

System tools are utility programs that help to maintain computer hardware and
software.

This component is used to set up the Windows environment. The bounce keys,
filter keys and sticky keys options are available in this dialog box.

This component is used to add new hardware to the system. Windows provides the
user the choice of detecting the hardware that is newly added and prompts the user
to install the hardware and the required software.

This component is used to customize the Start menu by adding or removing an
application program.

This component helps to connect to the internet, to set up a default home page, to
clear the history etc. This component provides a lot of ways to customize the internet
browser screen.
This component helps in customizing your desktop by allowing you to change the
wallpaper, screen saver, display adapter, view options etc.

This component is used to add a new printer/fax printers or remove an existing
printer/fax printers. It also provides the option of sharing the printer across the
network.

This component helps to view all the fonts that are available in the system and also
allows you to add remove fonts from your system.
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Some important system tools are

Backup :

The Backup tool allows backing up of files from a hard disk to a floppy disk. It can
also be used to backup files to a tape drive or to another computer on the network. In case
the original files are damaged or lost, they can be restored from the backup files.

Disk Cleanup :

The Disk Cleanup tool frees space on the hard drive. Disk Cleanup searches the hard
drive and lists temporary files and unnecessary program files that can be safely deleted.

Disk Defragmenter :

The Disk Defragmenter tool rearranges files and unused space on the hard disk so
that programs run faster.

ScanDisk :

The ScanDisk tool checks the hard disk for logical and physical errors. ScanDisk
also repairs the damaged areas on the hard disk.

Scheduled Tasks :

The Scheduled Tasks tool is used to assign tasks to run at a time. For example to run
a virus program on a specific time, the task can be scheduled in the Scheduled Tasks.

Maintenance of Computers

To keep your computer in proper working condition, it is necessary to protect the
hardware from unreliable power supply and natural calamities. The following are some
Do’s and Don’ts for a computer and its components:

General Precautions :

Points to be kept in mind while using your PC:

Do’s

 Keep the computer in a cool, dry and dust-free environment.

 Ensure that the power switches on the system unit, monitor and printer are in the
OFF position before switching on the main.

 Switch off the monitor, system unit and the printer, before switching off the mains.
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 Clean the work area of the computer everyday; cover your system at the end of the
day.

 Ensure that there is enough space between the system and the room walls so that
there is proper airflow around the computer.

Don’ts

 Do not eat or drink near the computer.

 Do not allow direct sunlight to fall on your computer.

 Do not run any electric equipment like a vacuum cleaner near the computer when it
is on.

Maintaining the System Unit

Do’s

 Handle the floppy drive lever gently.

 Ensure that there is no disk in the floppy drive before switching off the system unit.

Don’ts

 Do not switch on the system with the data floppy in the drive.

 Do not insert or remove the diskette when the drive select indicator is glowing.

 Do not switch off the system when the hard disk is active, i.e. when the indicator is
glowing

Maintaining the Monitor

Do’s

  Keep the brightness and contrast minimum before switching on the system and
increase it to the appropriate level thereafter.

Don’ts

  Do not try to open the VDU and try to touch the parts as these parts may carry high
voltage.
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Maintaining the Keyboard

Do’s

 Clean the keyboard regularly.

 Use a vacuum cleaner to clean keyboards as it can extract the dust collected.

Don’ts

 Do not strike the keys as hard as those of a manual typewriter since these keys are
soft touch.

 Do not rest your hands on the keyboard.

 Do not keep anything on the keyboard.

 Do not use the keys after switching off the system.

 Do not stretch the keyboard cable.

Maintaining the Mouse

Do’s

 Use a mouse pad.

 If you do not have one, make sure you place the mouse on a clean surface.

Don’ts

 Do not pull the mouse cable.

 Do not expose the mouse to excessive moisture.

Preventing Viruses

As you already know, an important aspect of maintaining a computer is to ensure that
the computer is free from virus. Let us now see the different types of software available to
ensure that your system is virus free.

Remember the golden rule, “Prevention is better than cure”. In fact, as is the case
with many viruses, prevention is the only cure because they cause irreparable damage to the
system. To protect your system from viruses, you should use anti-virus software.
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Anti-virus Software

An anti-virus software is a software or program that scans the hard disk (sometimes
called as virus scanners) and checks for the presence of viruses. If viruses are found, the
antivirus program removes them. Since the list of viruses is ever growing, anti-virus programs
often have to be updated on a regular basis. This enables them to fight out the latest viruses
on the prowl.

Types of Anti-virus Software :

There are many types of anti-virus software available in the market today. They can
be broadly classified as follows.

Software That Checks for Specific Signature:

Most viruses have strings of bytes that are characteristic of the type to which they
belong. These strings of bytes are called signatures. Anti-virus programs can be designed to
look for such signatures. The occurrence of files with these signatures gives away the
presence of a specific virus. However, a disadvantage with this type of anti-virus software is
that it can detect only known viruses.

Software That Checks for Specific Code

These are very similar to the previous category of anti-virus programs. However,
these programs check the code for specific code lines, most of which are otherwise not
present in normal programs. These programs detect files infected with viruses when the
files perform actions that are uncharacteristic of them. This type of anti-virus program is
quite useful in detecting new viruses.

Software That Checks the Integrity of Data

This type of program detects viruses by checking for the integrity of files or programs
over a period of time. It thus enables the detection of viruses that modify the contents of
files. The program calculates the checksum, which is a value obtained by performing some
binary calculations on the data, of all files and stores these values. When a need arises, the
checksum is calculated again. If it is found to differ from the value obtained before, it
indicates data modification, which could be due to a virus attack. These types of programs
are best suited for checking executables and other files whose contents do not change over
a period of time.
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Software That Intercepts a Virus in Action :

This class of anti-virus software, also called interceptors, helps in detecting and
stopping viruses that are currently active. These software programs generally reside in the
memory from start up to system shut down and watch out for viruses. They are of great help
because of their constant vigilance.

Summary

 Control Panel helps to manage the hardware and software components of the system.

 Network Neighborhood helps in viewing the information stored in different
computers on the network.

 System tools are utility programs that help to maintain computer hardware and
software.

 Anti-virus software are programs that scan the hard disk and check for the presence
of viruses.

 Shows the control panal working system.

1. Change the background of the desktop by using Control Panel.

2. Change the time settings of your computer by using Control Panel.

3. View the computers in your network.

4. Scan your system for viruses.

Fill in the blanks

1. The option in Control Panel is used to customise the desktop.

2. The _______________ tool frees space on the hard drive.

3. The ___________ system tool checks the hard disk for logical and physical errors.

 Scaning   Anti-virus   Network Neighborhood      Integrity of data
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Learning objectives

In this chapter you will be able to understand about ;

 State the need for networks

 Define a network

 List the different types of networks

 List the various components of a network

 Define basic terms related to networks

 List the types of LAN

 Define workgroup and domain

Networking

What is a network? A network refers to an arrangement of things. For instance, you
may have come across the sentence, ‘The state has a very good network of roads’. This
signifies that there is a good system of roads that reaches out to every corner of the state.
In other words, the cities, towns and villages of the state are well connected through the
wide network of roads. It also signifies that these cities, towns and villages are dependent
on the interconnectivity that this network of road provides.

We can extend this analogy to computers, too. When we say that a group of computers
is ‘networked’, it implies that these computers are linked by means of a communication
system. Technically speaking, the term ‘computer network’ refers not just to the computers
but includes the software that helps them communicate and the transmission methods used
in such communication. Therefore, it includes the whole range of hardware and software
components that make a computer network operate.

Thus, networking is the process of linking several computers  together in order to
enable them to communicate with each other. The interconnection of the hardware and
software components of a group of computers is known as a Network.

 Introduction to NetworkChapter - 8
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Advantages of Networking

 Networking allows sharing of files and documents among various systems in the
network.

 Networking allows sharing of hardware and software resources among various
systems.

 It also provides an improved communication link between users in a network

Types of Network :

Networks vary widely in their size, complexity and geographical spread. One way of
classifying networks is based on their geographical spread. On this basis, networks can be
classified into

 Local Area Network (LAN)

 Metropolitan Area Network (MAN)

 Wide Area Network (WAN)

Local Area Network :

A LAN is a group of computers and other devices distributed over a limited area and
connected by cables. Example: Computers in a school.

Metropolitan Area Network :

A MAN is a communication network that connects computers and other devices that
are distributed within the geographical boundaries of a city or town. Example: The railway
reservation system in a city.

Wide Area Network :

A WAN is a communication network that connects geographically separated areas
such as countries or even continents. Majority of the WANs use satellites as their primary
medium of transmission. Example: The Internet

Components of a Network

Components of a network can be classified into two headings namely logical
components and physical components.

The Logical components of a network consist of the Network Operating System
(NOS) and the associated protocols.
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The Physical components of a network comprise network adapter cards, cabling
systems that connect the computers, telecommunication lines, satellites and hubs.

Network Operating System :

The operating system that enables a computer to participate in a network is known
as the Network Operating System.

Some of the popular network operating systems are listed below.

   Variants of UNIX like IRIX, Linux, HP-UNIX and Solaris

    Novell NetWare from Novell

   Windows NT from Microsoft

Network Protocols

A protocol is a set of rules and conventions to be followed for sending and receiving
information over the network. The set of rules governs the following:

   The content of the information

   The format in which the information will be sent

   The timing and the sequence in which the information will be sent

   The error control messages that are sent

In a network, these rules are implemented through a set of software. Some commonly
used software for implementing these rules and conventions are listed below.

   Ethernet Protocol

   Transmission Control Protocol/Internet Protocol (TCP/IP)

Terms Related to Networks

Node

A node is a device that is directly attached to the network. Generally, the term is
used in the context of computers attached to a network. However, there are other devices
such as network printers that can be attached directly to a network. If these devices are
attached to a network, they are also referred to as nodes.
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Workstation

Workstations refer to the computers that are attached to a LAN and are seeking to
share the resources of the network. A workstation is also known as client. LAN connects all
the individual workstations together and each workstation has access to resources available
through the network. A workstation that is part of a LAN can still be used independently.

Server

A server is a computer that shares its resources with the other workstations in a
network. Servers are of two types: dedicated server and non-dedicated server.

Dedicated Server

A dedicated server is one that can work only as a server and cannot double up as a
workstation. This type of server is used in very large networks. Here the only job of the
server is to help workstations access data, software and hardware resources.

Non-dedicated Server

A non-dedicated server is simply another workstation. The computer acts as a server
by providing resources to the workstation on the network and also doubles up as a workstation.
This type of server is suitable for smaller networks, which have fewer workstations.

Types of LAN :

LAN can be classified into two types: peer-to-peer network and client/server
network.

Peer-to-peer network :

A Peer-to-peer network is a network in which every node can act as both a client and
a server. Each node can share its resources with other nodes on the network. Every computer
on this network takes an equal part in the networking process and is ideally suited for smaller
networks.

Consider a peer-to-peer network of four computers. Assume that ‘node2’ on the
network needs to access a PowerPoint presentation from ‘node3’. When ‘node2’ is accessing
the presentation from ‘node3’, ‘node3’ becomes the server and ‘node2’ becomes the client.
Now assume that ‘node1’ needs to access a file from ‘node2’. Here, ‘node2’ is the server
and node1’ becomes the client. Therefore, any system in a peer-to-peer network can act
both as a client and a server.
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Client/Server Network :

A client/server network involves using a powerful computer, which runs a network
operating system and acts as the server in the network. This network operating system
manages the communication link between the server and the client. In this type of network
setup, the administration of security and user account information is centralised. These
networks are easier to administer and control, especially in a large network setup.

Consider a client/server network of 20 computers. In this setup ‘node1’ is designated
as the server and it is the only system that can provide network services to the clients. The
remaining 19 nodes are designated as clients. In this setup, clients can never act as servers.

Workgroup

A workgroup is a logical grouping of computers on a network. Each workgroup on a
network is identified by a unique name. In this network setup, resources are shared among
the nodes and security information is distributed to each node that acts as a server. Peer-to-
peer network setup is otherwise called a workgroup.

In a workgroup, the maintenance of security becomes cumbersome as the network
grows. This is because there is no centralised administration of security information and
resources.

Domain

A logical grouping of computers and users that share a common security database is
known as a domain. This grouping of computers and users is done mainly to implement
security for users and resources. A client/server network setup is otherwise called a domain.

Summary

 The interconnection of the hardware and software components of a group of
computers is known as a Network.

 The three types of networks are LAN, MAN and WAN.
 Components of a network include:
 Logical Components – consist of the Network Operation System (NOS) and the

associated protocols.
 Physical Components – comprise the network adapter card, network cables,

telecommunication lines, satellites and hubs.
 The Network Operating System allows a computer to participate in a network.



SCERT, T.S, Hyderabad44

 A protocol is a set of rules and conventions to be followed for sending and receiving
information over the network.

 A node is a device that is directly attached to a network.
 Workstations refer to computers that are attached to a LAN and are seeking to share

the resources of the network.
 A server is a computer that shares its resources with the other workstations on a

network. Servers are of two types: dedicated server and non-dedicated server.
 Peer-to-peer network is a network in which every node can act as both a client and a

server.
 A client/server network involves using a powerful computer, which runs a network

operating system and acts as the server in the network.
 A workgroup is a logical grouping of computers, which enables users to browse the

network.
 A logical group of users and computers implemented for security purposes is known

as a domain.

 Show the network system of your lab.

 Observe network and identify familarity with school network.

Fill in the blanks

1. The interconnection of the ___________ and ___________ components of a group
of computers is known as a network.

2. WANs use ___________ as their primary medium of transmission.

3. The operating system that enables a machine to participate in the network is known
as the ___________ operating system.

4. A ___________ is a computer that shares its resources with the other workstations
on a network.

5. Peer-to-peer network is a network in which every node can act as a ___________
and a ___________.
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Learning Objectives

In this chapter you will be able to understand about ;

   Interface

   Application of Logo.

MSW logo is the perfect introduction to computer programming. You will give
commands, you will draw shapes and you will write procedures.

Your LOGO workspace looks like this:

TURTLE DIRECTIONS

 The turtle can go forward, back, right and left.

 Type FORWARD, press space and enter a big number like 200. Press Enter.

 Try using the BACK command.

 To turn the turtle, we have to tell it to turn right or left.

Try : RIGHT ______

You will type your instructions into the input box. Your instructions are recorded

in the command box.

LEFT ______

You will type your instructions into the input box. Your instructions are recorded  in
the command box. The turtle can draw shapes with it’s pen.

So, when using the FORWARD and BACK commands the turtle moves around the
screen, but using LEFT and RIGHT only turns the turtle and does not move it. Got it?!
Practice moving the turtle around the screen!

TURTLE SHORTHAND

 If you don’t want to see the turtle, type HIDETURTLE or HT.

 To show the turtle again, type SHOWTURTLE or ST.

MS LogoChapter - 9
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We can write Turtle commands in shorthand :

FD =

BK=

RT=

LT=

Summary

 In this chapter we have learnt about;

 MS Logo.

 Demonstrate the working of MS LOGO.

 Draw Line diagram.

 Turtle  Command box

*****
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Learning Objectives

In this chapter you will be able to understand about ;

View presentations in different modes like

• Normal view

• Slide sorter view

• Notes Page view

• Slide show view

• Change the background of slides

• Apply design templates

• Change the slide layout

• Change the colour scheme

• Add slide transitions

Views in PowerPoint

While creating a presentation, sometimes it is
helpful to see the entire content to reorganize it and to
see what the audience will see during the presentation.
PowerPoint has several ways of viewing your slides
while creating it.

To change the view:

1.   Click the View tab.

2.   Click the required view (refer Figure 1).

Normal View

Normal view is the main editing view, which you use to write and design your
presentation. The screen is split into three sections. On the left, there are tabs that alternate
between an outline view of your slide text (Outline tab) and your slides displayed as

Figure 1: Changing the View

Chapter - 10 More about Microsoft Power Point
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thumbnails (Slides tab). On the right, there is the slide pane, which displays a large view of
the current slide. At the bottom, there is a pane to enter notes (Refer Figure 2).

Slide Sorter View

A small image of each slide is displayed in the Slide Sorter view. Slides can easily
be ordered and sorted from this screen (Refer Figure 3).

You can use the icons on the Slide Sorter toolbar to set timings for a slide show and
to apply animations and transitions. You can also easily move and copy slides in this view.

 

Figure 2: The Normal View

Outline
Slide tab

Thumbnails
of Slides

Enter Notes here

Figure 3: The Slide Sorter View
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Notes Page View

The Notes Page view is
used to enter notes for slides
within a presentation. Each notes
page includes an image of the
associated slide, below which
there is an area where you can
enter text. Notes pages act as a
script for the presentation. It can
hold as much text as it can fit on
one page (Refer Figure 4).

Slide Show View

The Slide Show view displays slides in full screen mode. When you use this view,
the PowerPoint window is not visible and each slide occupies the complete screen area.
This view helps you see how the slide will actually look like when the presentation is made.

Changing the Background of the Slides

You want to change the background of the slides to
yellow. You can change the appearance of your slide
background by changing its colour, shade, pattern or
texture. You can also use a picture as a slide background,
but you cannot use more than one picture.

To change the colour or the effect of the existing slide
background:

1. Select the slide for which you want to apply a
colour.

2. Right click the slide.

3. Select the Format Background option.

4. A Format Background dialog box is displayed.

5. Select the colour by clicking the Color list box. (Refer Figure 5)

Figure 4: The Notes Page View

Figure 5: The Notes Page View
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6. If the colour is not available in the colour
scheme, click the More Colors option and select the
color you want.

7. To apply the change to the current slide, click
the Close button. To apply the change to all the slides,
click the Apply to All button.

The background of your slides has changed (Refer
Figure 6).

Applying Design Templates

A design template is a slide that has a pre-
defined background design, background colour,
font style and font colour. This can be applied to
the slides in your presentation. A variety of design
templates are available. You have to choose a
template that will best suit your presentation. The
design templates can be applied in the beginning,
when you create a new presentation. You can also
change the design of your slides at any point of
time.

To change the design template

1.   Click on the Design tab. Various design templates will be displayed in the Themes
      group. (Refer Figure: 7)

2.   Move the mouse on each template to see the preview.

3.   Select the design template by clicking it.

4.   The design template will be applied to all the slides.

If you want the design template to be applied to
one or more selected slides, then click the Apply to
Selected Slides option. If you have not selected any
slide, it will apply the layout to all the slides.

Figure 6: Slide after changing the
background

Figure 7: Design templates

Figure 8: Applying a design template



ICT Teacher Hand Book 51

5.   Right-click on the Design Slide. From the pop up box displayed select the required
      option. (Refer Figure 8)

Changing the Slide Layout

Suppose you want to make the slide
containing the list of domestic animals
into a clipart and text slide. To do this, you
need not insert a new slide with the
preferred layout and type the whole text
again. Instead, you can change the layout
of the existing slide.

To change the slide layout:

1.   Select the slide to which you want
      layout to be changed.

2.   Click the Home tab.

3.   Click the Layout option from the Slides group.

The Module task pane appears (Refer Figure 9).

4.   Use the scroll bar to view all layouts. Select the required layout, in this case, the
     Content with Caption layout.

The selected layout is applied to the slide.

Now, you can add the clipart of your choice to this slide.

Adding Slide Transitions

Transitions control how slides will switch from one to the next during a slide show.
Transitions provide different effects for advancing to the next slide.

To add transition effects to your slides:

1. Select the slide to which you want to apply transition.

2. Click the Animation tab.

3. From the Transition to This Slide group, select the type of transition that you want
to apply. (Refer Figure 10)

 

 

Cont ent
with
Caption

Figure 9: Changing the slide layout
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4. Transition effect is applied to the slide. To apply the transition effect to all the
slides,

5. Click Apply To All button from Transition to This Slide group. (Refer Figure 10)
Your presentation is now ready to be displayed before the class.

Note : Select the On mouse click check box to advance the slides only when you click the
mouse or press the required key on the keyboard.

Select the Automatically after check box for the slides to advance automatically.
You can specify a time in the spinner box below.

Summary

PowerPoint has different types of views that help you in constructing your
presentation. Some of them are:

• Normal view – The screen is split into three sections showing the presentation
outline on the left, the slide in the main window, and notes at the bottom.

• Slide Sorter view – A small image of each slide is displayed in Slide Sorter view.
Slides can easily be ordered and sorted from this screen.

• Slide Show view – This view is used to see the full-screen slide show.

• Notes Page view – The Notes Page view is used to enter notes for slides within a
presentation.

• You can change the appearance of your slide background by changing its colour,
shade, pattern or texture using the Background option on the Format menu.

• Pictures can also be used in the background.

• To change a slide layout, click the Layout option on the Home tab.

• The transition style determines how one slide is removed from the screen and the
new one is displayed during the slide show.

Figure 10: Applying a Slide Transition
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• Demonstrate the animation & transition of Power Point.

• Hand on practice for animation & transition.

• Start PowerPoint.

• Create a presentation titled “Uses of Computers”. It must have at least five slides.

a)   Change the background to blue.

b)   Insert some pictures on computers.

c)   Add notes to each slide using the Notes Page View.

d)   Apply a design template.

e)   Add different slide transitions to each slide.

• Save the presentation as “computers.ppt”. Use the Slide Show view to run the
presentation.

Fill in the blanks

1. The __________ view shows small images of each slide where slides can be
ordered and sorted easily.

2. The __________ view is used to enter notes for slides within a presentation.

3. __________ controls how slides will switch from one to the next during a slide
show.

4. The design templates are available in the __________ tab.

5. __________ control how slides will switch from one to the next during a slide
show.

• Transition

• Colour Scheme
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Formatting in Word

Learning Objectives

In this chapter you will be able to understand about ;

 Change the font type, size, colour and style using the formatting toolbar

 Use the Font dialog box

 Change the case of text

 Change the line spacing

Formatting Text

Word allows you to change the appearance of text so that it looks better. This can be
done by changing the font used in the Word document.

Font refers to the manner or style in which text is displayed in your document. You
can change the font type, font size, font colour and font style. This change in the style or
appearance of text is called formatting. For this, you need to use the formatting toolbar.

Changing the Font Type

The text is currently in the font Times New Roman.
You want to change it to Comic Sans MS.

To change the font :

1.   Select the text.

2.   Select a font from the Font drop-down list on the Font
group from the Home tab. (refer Figure 1).

The font of your text will change as shown below.

 

 

Figure 1: Changing the font type
using the formatting toolbar

Chapter - 11 Formatting in Microsoft Word
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The Solar System is like a family made of objects in the sky. The sun forms the
center of the solar system. It is surrounded by the other family members namely
planets, moons, asteroids and comets.

The Solar System is like a family made of objects in the sky. The
sun forms the center of the solar system. It is surrounded by the
other family members namely planets, moons, asteroids and comets.

Text after changing the font to Comic Sans MS

Changing the Font Size

To change the font size of the heading to 20:

1.   Select the heading.

2.   Select 20 in the from the Font Size drop-down list on the Font

      group from the Home tab. (refer Figure 2).

The font size of the heading has changed as shown below.

Figure 2: Changing the Font size

The Solar System

The Solar System is like a family made of objects in the sky.

To format text using the Font dialog box:

1.   Select the text to be formatted.

2.   Click the Home tab.

3.   Click the Font dialog box launcher in the Font group (An arrow next to the Font
group).

The Font dialog box appears as shown in Figure 4.

 

 

 

 

Figure 3 : Font dialogue box launcher

dialogue box
launcher

Font
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4.   Select the required options for font type, font size, font colour and font style.

5.   Click the OK button.

Changing the Font Style

You want to underline the main heading. You also decide to make the sub-headings a
bit thicker than the rest of the text and slant them. Word provides you with many styles like
Bold, Italics and Underline.

     The Bold option makes your text thicker.

     The Italics option makes your text slant to the right side.

     The Underline option puts a line below your text.

1. Select the heading and press the          button on the font group from the Home tab,
to underline the main heading.

2. Select each sub-heading and press the          button on the font group from the Home
tab, to make them thicker.

3. Use the       button on the font group from the Home tab, to italicise the sub-
headings. Note that the font styles of the text have changed (refer Figure 5).

 

 Font Style

Font Size

Font Type

Font Colour

Figure 4: The Font dialog box
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Changing the Case of Text

If you want to change a sentence from
lower case to upper case, you need not type
the whole sentence once again. You can use
the Change Case option of Word.

For example, you want to change the sub-headings in your
text to upper case. All you need to do is:

1.   Select the heading.

2.   Click the Home Tab.

3.   Click the arrow next to the
Change Case (Change Case
list) from the Font group. (Refer Figure 7)

The Change Case dialog box is displayed as shown in
Figure 7.

4.   Select the UPPER CASE option.

5.   Click the OK button.

The selected text has now changed to upper case (refer
Figure 8 ).

 

 

Figure 5 : Text after applying changes to the font

Bold and
Underlined text

Bold and
Italicised text

 

Figure 6 : The Change Case dialog box

Figure 7 : The Change
Case dialog box

 

 

 

Figure 8 : Text with
Upper Case
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The various options in the Change Case dialog box are:

Sentence case – Capitalizes the first letter of the selected sentence.

Lowercase – Changes the selected text to lowercase.

Uppercase – Changes the selected text to uppercase.

Title case – Changes the first letter of every word in the selected sentence to
uppercase.

Toggle case – Changes all uppercase letters in the selected sentence to lowercase,
and all lowercase letters to uppercase.

Changing the Line Spacing

Line spacing refers to the amount of space from the bottom of one line of text to the
bottom of the next line. Word bases the line spacing on the font size of the text. The line
spacing you select will affect all lines of text in the selected paragraph.

Word uses single line spacing by default. You want to change it to a line spacing of
1.5 lines. To change spacing between lines:

1. Click the Home Tab.

2. Click the Paragraph dialog box
launcher (Refer Figure 9). The
Paragraph dialog box appears as
shown in Figure 10.

3. Select the Indents and Spacing tab.

4. In the Spacing section, change the
value in the Line Spacing drop-
down list to 1.5 lines.

5. Click the OK button.

The line spacing between the lines
in your document has changed (refer
Figure 11).

Paragraph dialog box
launcher

 

Figure 9 : Paragraph dialog box launcher

 

Change the line
spacing here

Figure 10 : The Paragraph
dialog box
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Summary

We have learnt about; Changing the appearance of text is called formatting.

      You can change the font type, its size, style and colour using the formatting toolbar.

      The Font dialog box can also be used to change the font properties.

      The Change Case option helps in changing the case from one to another.

  The Paragraph option on the Home Tab is used to maintain uniform spacing between
lines of text.

      Word 2007 offers several new features that make it easier to work with documents.

1.   Create a new Word document and type the following text.

The Air around us

The atmosphere is a mixture of many gases. The constituents of air are nitrogen,
oxygen, carbon-di-oxide, argon and others.

Nitrogen

Nitrogen forms the major constituent of air with 78% by volume. It is not a reactive
gas under normal conditions. Nitrogen compounds are essential for plant growth. Plants
make proteins from nitrates. Proteins are the building materials of all living things.

Text with line spacing of
1.5 lines

 

Figure 11: Changed line spacing in the document

Student Activity
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Oxygen

Oxygen is the next largest constituent of air with 21% by volume. Oxygen helps
combustion. Burning of candle, kerosene, petrol etc are examples of combustion.
Respiration and rusting are also examples of combustion.

Carbon-di-oxide

The amount of carbon-di-oxide is very little (about 0.03%). But this amount increases
due to pollution. Carbon-di-oxide is used in fire extinguisher and aerated drinks. Dry ice is
used for cooling ice cream, packing fish and to deep-freeze some foods.

2.   Make the following changes to your document.

a)   Change the font type of the entire text to Courier New.

b)   Change the font size of the main heading to 18 points and underline it.

c)   Change the font size of the sub-headings to 14 points.

d)   Change the font colour to blue.

e)   Italicise all sub-headings.

f)    Change all the headings to bold.

g)   Change the line spacing of the entire text to 1.5 lines.

h)   Change the case of the sub-headings to title case.

i)    Change the main heading to upper case.

3.   Save the document.

Fill in the blanks

1.   The _________ group helps you to change font style and font size.

2.   You can use the _________  option on the Font group to change the character case.
font style makes your text look bolder.

3.   The _________ option is used to give multiple line spacing.

4.   The_________  option changes the selected text to lowercase.

*****

Test Your Knowledge
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Learning Objectives

In this chapter you will be able to understand about ;

 Open a Workbook

 Navigate a worksheet

 Enter and edit formulae

 Calculate totals by using the Formula Ribbon

 Copy and move formulae

Opening a Workbook

To continue working
on the “Marks.xlsx”
workbook, you need to open
it. To open an existing
workbook:

1. Click the Office Button.

2. Click the Open option.

The Open dialog box
appears as shown in
Figure 1.

3.  Select the workbook you want to open.

4.  Click the Open button.

Navigating a Worksheet

When you work with a worksheet, it is essential to know how to move around the
worksheet. Moving within a worksheet or workbook by using the mouse or the keyboard is
called navigation. There are various methods for navigating worksheets.

Figure 1: The Open dialog box

Chapter - 12 Formulas and Functions in
Microsoft Excel
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Summarises various worksheet navigation techniques:

Technique Function

Clicking a cell Makes the cell active.

Arrow keys Moves the active cell left, right, up or down one row or column.

Enter Moves the active cell one row down

Shift + Enter Moves the active cell one row up

Tab Moves the active cell one column to the left

Shift + Tab Moves the active cell one column to the right

Ctrl + Home Moves the active cell to cell A1

Table 1: Navigation Techniques

The Page Up or Page Down keys can be used to move up or down the worksheet. To
move the cursor to a particular cell in the worksheet:

1.   Press the F5 function key.

      The Go To dialog box appears.

2.   Type the required cell address in the Reference text box.

3.   Click the OK button.

Tip : Alternatively, type the cell address in the Name box to position the cursor on the
required cell.

To move quickly within a worksheet, you can use the scroll bars. There are two
scroll bars on an Excel window. The one on the right side is called the vertical scroll bar and
the one at the bottom of the worksheet is called the horizontal scroll bar. Each scroll bar
has a triangular button at each end and a scroll box on it. To move within a worksheet, click
a triangular button or click and drag the scroll box.

Entering and Editing Formulae

You have entered the marks scored by the students. The next step in preparing the
marks statement is to calculate the total marks scored by each student. You can do this
manually or by using a calculator. However, Excel allows you to perform calculations faster
by using a formula. A formula can be used to perform numeric calculations such as addition,
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subtraction, multiplication, etc. An Excel formula begins with the equal to sign (=). A formula
can refer to a value, a cell address or another formula.

Operators form a very important part of a formula. These operators indicate the type
of operation that the formula will perform.

Before you start calculating the total marks, type the label “Total” in cell E4.

To find the total marks scored by the first student, you have to calculate the total
marks in cells B2, C2 and F2 and display it in cell G2. To do so:

1.   Click the cell E2 below the label “Total”.

2.   Type the following formula:   =B2+C2+D2+E2+F2

3.   Press the Enter key.

The result appears in cell G2 (refer Figure 2).

Figure 2: Entering a Formula

Note : You can use all the other arithmetic operators in the same way as the addition operator
(+).

One of the important features of Excel is automatic recalculation. Whenever the
value of a cell used in a formula is changed or deleted, the result of the formula changes
automatically.

Note : The cell addresses used in a formula are called cell references.
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Using the Mouse to Enter Cell References

You can use the mouse to enter cell references in a formula. To do so:

1.   Select the cell in which you want to enter the formula.

2.   Type = (to begin the formula).

3.   Click the cell for which you want to enter a reference in the formula.

4.   Type the required operator.

5.   Repeat steps 3 and 4 until you have created the desired formula.

6.   Press the Enter key.

A formula can be edited as you would edit any other data. Double-click the cell that
has the formula you want to edit and enter the correct formula.

Using the Auto Sum Feature

A simpler way to find the total of a range of numbers is by using the AutoSum feature.
For example, to calculate the total marks obtained by a student:

1.   Place the cell pointer on the cell E5.

2.   Click the AutoSum  icon on the Editing group.

Note that Excel inserts the formula for you. However, you can make any changes to it.

3.   Press the Enter key.

The result appears in the selected cell.

Note : The AutoSum feature will only add the numbers in the cells, which are to the left or
above the active cell. This feature can be used only when the numbers to be added are placed
in continuous cells.

Copying and Moving Formulae

You had typed a formula to calculate the total marks scored by the first student. You
now have to calculate the total marks of all the other students. To do this, you do not have to
type the formula into each and every cell. You can copy the formula specified in cell E5 to
the cells from E6 to E14. This will save both time and effort.

A formula can be copied or moved from one location to another.
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Copying Formulae

To copy a formula :

1.   Select the cell G2 that has the formula to be copied. This is the source cell.

2.   Click the Home Tab.

3.   Click the Copy button from the Clipboard group.

4.   Select the group of cells (G3:G6), where the formula has to be pasted. These cells
     are called the destination cells.

5.   Click the Paste button from the Clipboard group.

The formula gets copied to the cell range G3:G6. Figure 3 shows the total marks
calculated for all the students.

Figure 3: Copying formulae using the menu

Alternatively, the drag and drop method can be used to copy a formula. To do so:

1. Select the cell G2 from where the formula has to be copied.

2. Place the mouse pointer on the lower right hand corner of the cell.

The mouse cursor will change to a “+” symbol.

3. Click the left mouse button and drag the mouse till you reach the cell G6 (refer
Figure 4).

4. Release the mouse button.

The formula gets copied to the selected range of cells.
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Similarly, you can enter a formula in cell G2 to calculate the average marks scored
by the first student and copy the formula to the other cells to calculate the average marks
scored by all the other students.

Figure 4: Copying a formula by using the drag-and-drop technique

Note : The drag and drop technique can be used to copy cells only when the source cell and
destination cells are in the same row or column.

Moving Formulae

To move a formula from one location to another:

1.   Select the cell that contains the formula.

2.   Click the Home Tab.

3.   Click the Cut   button from the Clipboard group.

4.   Select the location where the formula has to be pasted.

5.  Click the Paste  button from the Clipboard group.

Note : When a formula is cut from a worksheet, it can be pasted only once.

When a formula is copied from a worksheet, it can be pasted any number of times.
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Summary

 To open an existing workbook, click the Open option on the Office button.

 You can navigate a worksheet by using the mouse or the keyboard.

 The AutoSum feature enables you find the total of a range of cells.

 The Copy option of Excel enables you to duplicate cell contents.

 The Move option of Excel enables you to move the contents of a cell from one
location to another.

 Demonstrate working with Excel.

1. Start Excel.

2. Make your class timetable by using Excel worksheet.

3. Save the file with the name “Schedule”.

4. Create a marks statement in Excel. Save the file as marks.xlsx.

Column A has the label Roll No, column B has the label Names, column C has the
label Marks and column D has the label Percentage.

5. Move the entries “Grand Total” and “Average” to cells A10 and A11 respectively.

6. Copy all the cells and paste them in Sheet2.

7. Save the file. 8. Close the file. 9. Exit Excel.

Fill in the blanks

1. The                   option on the Office Button can be used to open an existing workbook.

2. Moving around a worksheet by using the mouse or the keyboard is called

3. Pressing the                   key moves the active cell one row down.

4. The drag and drop technique can be used to copy a formula only if the cells are

*****

Teacher Activity

Test Your Knowledge

Student Activity
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Surfing the Internet

Learning Objectives

In this chapter you will be able to understand about ;

 Know what is WWW

 Explain the advantages of using WWW

 Define URL

 Define the term Web browser

 Use the Internet Explorer to browse

 Recall the terms used in Internet

World Wide Web

WWW stands for the World Wide Web. It is a series of interconnected servers that
contains information in form of text, pictures, sounds and animation.

You would have seen a library. It consists of millions and millions of books with
pages of text, pictures, sounds and animation. WWW is very similar to a library. Just like a
library, WWW has information on different topics. These information pages are stored on
different computers that are connected to the Internet and have links between them. When
you click on a certain word, which is a link in the page, it will take you to another page. Such
text, which act as a link between Web pages, are called hypertext. These links are called
hyperlinks and the pages are known as Web pages. A collection of related Web pages is
known as a Web site, which is similar to a book containing related information. The first
Web page that gets displayed when the user opens any Web site is called the Home page.

Advantages of Using WWW

The advantages of WWW are:

 A user can click any hyperlink present on the Web page and jump to a related Web
page on the same or a different Web site.

 A Web page can contain text, pictures, audio, and video clips which makes it
interesting to the user.

Chapter - 13 Internet
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 A user can interact with a Web page by filling a form, by running a program or select
options from a Web page.

URL

You know that each house has an address. The address has a door number, street
name, city name and pin code. The address is used to locate a house easily. Similarly each
web site has an address. This address is called the URL (Uniform Resource Locator) to a
Web site.

Examples for Web site address are:

 www.yahoo.com

 www.hotmail.com

 www.google.com

Web Browsers

We are already aware of the process of connecting to the Internet. But, more than
connecting to the Internet, you should be able to use the services provided by the Internet.
For example, you may use WordPad to type a letter and Paint to draw a picture. Likewise,
Web Browser is a software program using which you can open any Web site to browse and
avail the services offered by the Web site. Web browsers are capable of displaying Web
pages containing text, pictures, sound and video files.

The commonly used Web browsers are:

 Internet Explorer

 Netscape Navigator

 Hot Java

 Opera

Using the Internet Explorer

The Microsoft Internet Explorer is a Web browser developed by Microsoft. The
Internet Explorer comes free when you buy Windows 98 or Windows 2000 or Windows XP
operating system.
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To launch Internet Explorer:

Double-click the Internet Explorer icon ( ) present on the desktop. Alternatively,,

1.  Click the Start button.

2.  Click the Internet Explorer option from the menu.

The Internet Explorer window opens up as shown in Figure 1

Figure 1: Microsoft Internet Explorer Window

The Internet Explorer window has title bar, menu bar, toolbar, address bar and status
bar. To visit a web site, you have to type the Web site address in the address bar and press the
Enter key. The home page of the corresponding Web site will be displayed (refer Figure 2).

Figure 2: Yahoo Home Page

Click the Forward button on the toolbar to move to the next page and the Back
button to go to the previous Web page visited.

 Title Bar

Menu Bar
Address
Bar
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Terms Used in the Internet

Let us recall the Internet terms, which you have already learnt.

 Web browser is a software that allows the user to display and interact with a Web
site.

 Web page is a page which may contains text, pictures, audio, and video clips.

 Web site is a collection of related Web pages.

 Home page is the first Web page displayed when the user opens any Web site.

 Hypertext Transfer Protocol (HTTP) is a protocol used on the WWW to transfer
Web pages. A protocol is a set of rules that the computers follow to communicate
with each other.

 HTML (Hypertext Markup language) is a language used to create Web pages.

 Uniform Resource Locator (URL) is a Web addressing system that is used to identify
each Web site uniquely on a network.

Example of an URL: http://www.aub.edu/services/faq.html

Summary

 WWW stands for the World Wide Web. It consists of millions and millions of Web
pages.

 Collection of related Web pages is known as Web site that is stored on different
computers that are connected to the Internet.

 Hyperlinks are used to link the related Web page.

 Web page is a page which may contains text, pictures, audio, and video clips.

 Home page is the first Web page displayed when the user opens any Web site.

 A protocol is a set of rules that the computers follow to communicate with each
other.

 Hypertext Transfer Protocol (HTTP) is a protocol used on the WWW to transfer
Web pages.

 HTML (Hypertext Markup language) is a language used to create Web pages.
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 Uniform Resource Locator (URL) is a Web addressing system that is used to identify
each Web site uniquely on a network.

 Internet Explorer is a Web browser developed by Microsoft.

 A Web browser is a program that enables you to view the Web site available on the
WWW.

 You can open the Internet Explorer using the Internet Explorer icon on the desktop.

 The Internet Explorer window has the Address bar where you type the Web site address.

 Explain the surfing of net.

 Browse the net using search option.

Fill in the blanks

1.                         is software that allows the user to display and interact with a Web site.

2.                           is a collection of related Web pages.

3. HTTP stands for                                .

4. HTML stands for                                .

5. The address of a Web site is also called                                .

6. WWW stands for                                            .

7.                   are the pages on the Internet that contain text, pictures, sounds and
animation.

8.                       is a set of rules that the computers follow to exchange information.

9. You have to type the Web site address in                      bar.

10. The first page that appears after opening a Web site is known as                         .

Teacher Activity

Student Activity

Test Your Knowledge
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Lab Work

1. Visit http:/ http://www.nineplanets.org/ to collect information about the solar system.

2. Visit http://www.nationalgeographic.com/kids/creature_feature/archive/ to view
photographs of animals and collect information about them.

3. Visit http://www.petsmart.com to gather information on your favourite pet..

4. Visit http://www.mapsofindia.com/maps/andhrapradesh/andhra-pradesh-district.htm
to view the map of Andhra Pradesh.

5. Visit www.indiatravelinfo.com/wildlife.htm to learn about wildlife sanctuaries in
India.

6. Browse the site http://www.historyofindia.com to get information about Indian
history.

7. Visit http://www.jiskha.com/social_studies/world_issues/ozone_depletion.html and
learn about ozone depletion.

*****
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Database Concepts

Learning Objectives

In this chapter you will be able to understand about ;

 Understand database concepts

 Define DBMS

 Understand the concept of primary key

Introduction to Database

Every organisation maintains data pertaining to its business, employees and finances.
This data needs to be maintained in such a manner that it is easily available whenever required
and it can be presented in any desired format. The data also needs to be updated regularly.

Traditionally, data was maintained in paper files. The following are the disadvantages
of manual data maintenance by using paper files:

  Data Redundancy   Slow data access

  Security problems   Integrity problems

These disadvantages can be overcome by using computers to maintain databases. A
database is a collection of interrelated data of a particular type. For example, a database
can contain data about all the products in a manufacturing company, or data about all the
students in a university, or data about weather conditions in an area or a city.

Databases help you organize related information in a logical manner for easy access
and retrieval.

For example, a telephone directory can be considered as a database. The individual
details, such as name, address and phone numbers form the data in the database. In a telephone
directory, names, addresses and telephone numbers are arranged in the alphabetical order
of names so that you can locate information quickly and easily. If the names were not in
alphabetical order, it will be difficult to search for an individual’s telephone number or
address.

Another example of a database is a dictionary, in which the words are arranged
alphabetically. A computer database is also a collection of data related to a particular subject
or purpose. For example, a cricket database will be a collection of information about cricket

Chapter - 14 Getting started with Microsoft
Access
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players. A database can store data in different formats, from simple lines of text to complex
data structures that include pictures, sounds or video images. The information stored in a
database is contained in the form of one or more tables. Every table in a database is designed
to contain data about a specific entity.

A table stores data in a row and column format. Consider the Player Details table
shown below (refer Table 1). The table is divided into several rows. For example, each row
in Player Details table contains data about a player. These rows of data are called records.
The columns of data in a table are called fields. The Player Name column is a field in the
Player Details table. Thus, fields store a particular type of data.

Table 1: The Player Details table

Every specific instance of data in a table is a value. In the first row, Sachin Tendulkar
is the value in the Player Name field and 250 is the value in the Wickets Taken field. A value
is located at the intersection of a row and a column.

Database management involves creating a table and adding, modifying and deleting
data from tables. The software that allows you to perform these functions is known as a
Database Management System (DBMS). The primary objective of a DBMS is to provide a
convenient method of storing and retrieving information from a database.

Some popular DBMS are Access, Clipper and FoxPro. Some of the advantages of a
DBMS are as follows.

  Large amount of data can be stored in a database.

  Calculations on data can be done with speed and accuracy.

  Storing, processing, modifying and retrieving data can be done easily.

Introduction to Access

Microsoft Access is a powerful multi user DBMS developed by Microsoft
Corporation. It is used to store and manipulate large amounts of information.

 

Player Id 
 

Player Name 
 

Runs Scored 
 

Wickets Taken 

P001 Sachin Tendulkar 10000 106 
P002 Saurav Ganguly 6300 57 
P003 Anil Kumble 560 250 
P004 Rahul Dravid 7800 4 

P005 Michael Bevan 5400 70 

 Field

Record
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Access enables you to:

  Create tables to organize data into manageable related units.

  Enter, retrieve and modify data.

  Extract information based on specific criteria.

  Create forms to enter data.

  Generate reports.

Database Objects

Access allows you to develop easy-to-use forms and create meaningful reports. An
Access database consists of database objects such as tables, queries, forms, reports, pages,
macros and modules. These objects are stored in a single database. The database objects are
discussed below.

Tables – Contain data about a particular topic. In a table, data is arranged in a row and
column format.

Queries – Retrieve information from a database on the basis of one or more
conditions. The set of records returned by a query is known as a dynaset. For example, a
query in a cricket database can be used to extract details of players in the England team.

Forms – Provide an easy-to-use interface for users to enter, view and modify data
in a table.

Reports – Present data from tables in a printed format. It is also possible to generate
a report based on a query.

Pages – Enable users to view data stored in an Access database or a SQL Server
database on the Internet.

Macros – Are a series of commands and functions that can be executed to perform
a specific task. For example, you can create a macro to print a report automatically.

Modules – Are a set of Visual Basic programs that are used to perform advanced
database operations.

Primary Key

The data available in a database needs to be checked for accuracy and correctness. In
order to ensure this, data integrity has to be enforced. Data integrity refers to the process
of maintaining error-free data that can be easily retrieved from the database. In order to
maintain data integrity, it should be possible to identify every record in the table uniquely.
For this, every table should contain a field that uniquely identifies each record. This field is
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called the primary key of the table. Once you set a primary key for a table to ensure
uniqueness, Access will prevent any duplicate values from being entered in the primary key
field, that is, two records cannot have the same value in the primary key field of a table.

In the example of the Player table given above, there can be cases where two players
have the same name. Hence, the Player name cannot be the primary key of the table. To
ensure that each player is always identified correctly, a unique reference value can be attached
to each player, just like how each student in a class has a roll number. The Player No is the
primary key in the Players Details table.

The primary key helps in uniquely identifying the records in a table. Thus, they play
a very important role in database management.

Summary

 Database is a collection of related data.

 DBMS provides the structure for data storage and mechanism for retrieving and
maintaining the database.

 Database stores data in tables.

 Data is arranged in a row and column format in a table.

 The primary key helps in uniquely identifying the records in a table.

 Demonstrate the creation of data base using the database wizard.

Fill in the Blanks

1. A                               is a collection of interrelated data.

2. The                               key is used to uniquely identify the records in a table.

3. The set of records returned by a query is known as                            .

*****

Teacher Activity

Test Your Knowledge
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Projects
1. Prepare a Word document on our national symbols with images.
2. Prepare a list of your classmates, their age, gender, hobbies and what they

want to become in future.
3. Prepare a tree diagram on classification of animals by using word document.
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